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Where do you go to search out 
new job or career opportunities? If you have 
such a place, do they have regular meetings 
that allow you to learn while you’re 
networking? How do you go about 
discovering new ways to do things or get your 
grammar or software questions answered? Do 
you even have a place, or do you look for 
answers online? How about volunteers to 
assist with a class or provide professional 
interviews for students? Need assistance with 
a resume or an article or with finding 
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additional professional resources? No idea 
how to put together a portfolio or create a 
Web site with full index? By the way, how 
much would you pay for all this? 
 

Welcome to the Orlando Chapter STC, 
where networking is included in your 
chapter affiliation! We’ll see you on the 
fourth Tuesday of the month at the Winter 
Park Civic Center. Networking begins at 
6:30 and program at 7:00.  MtMMtMMtM 

Tuesday, September 28th at 6:30 PM 

The Plug and Play Technical Communicator: 
Providing Value at All Stages of a Product Life 
Cycle 
By Christina Hammock, Orlando Chapter Vice President 

What do you do when the 
project’s over? As technical communicators 
we need to adapt to change and seek 
opportunities for growth. At our September 
28th chapter meeting, Mark Hanigan, a 
former STC Society President, will introduce 
us to project life cycle documentation.  
 
Mark will begin with an overview of project 
life cycle documentation and discuss the 
opportunities it offers for technical 
communicators who want to expand their 
skill sets and perhaps even branch out into 
related fields such as project analysis and 
project management.  
 
Mark will then discuss Intellectual Property 
(IP) Harvesting.  This is a concept we more 
often refer to as content reuse or content 
management. IP Harvesting enables the reuse 
of the products we create as technical 
communicators, both within a deliverable set 
for one project and across deliverables for 
other projects.  
 
The presentation will conclude with an 

explanation of how technical 
communicators are best suited to lead this 
effort, including a discussion about steps 
that we can take to further prepare 
ourselves for this challenge and how we 
can effectively implement and integrate the 
results in our work. 
 
This presentation will surely be an 
inspiration to us all as we look forward in 
our careers and seek opportunities for 
advancement in our field. I hope to see you 
all there!   
MtMMtMMtM 

Winner of STC’s 
Chapter of  

Distinction Award, 
2003 and 2004 

Plug In with Us!Plug In with Us!  
Tuesday, Sept. 28thTuesday, Sept. 28th  

6:30 PM 6:30 PM   
Winter Park Civic Winter Park Civic 

CenterCenter  
Fees (cash or check):      
$5 - Student members 
$8 - Student visitors  
$8 - Members 
$12 - Visitors 

RSVP by 9/27/04 to:  
vicepresident@stc-orlando.org 
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Giving Back: STC Members Volunteer at UCF 
By Jennifer Selix, FTC President and STC Education Committee Member 

The bond between STC Orlando and the 
University of Central Florida is 
stronger than ever.  Student 
membership is on the rise, our 

Mentorship Program is about to kick 
off its second year, and ten UCF students will be 
joining us at the 2005 Conference in Seattle.   
 
Now, yet another opportunity has arisen for our 
professional and student members to join forces.  
Led by Jennifer Selix and Bonnie Spivey, our 
professional members have and will volunteer their 
time and expertise to help enhance the technical 
skills of UCF students and other interested members 
of the STC community. 
 
On Saturday, September 18, Bonnie Spivey  taught 
a workshop on Microsoft styles applications.  Her 
agenda included template creation and uses, as well 
as tips for organizing existing styles.   
 
On Saturday, September 25, 
our STC Orlando Chapter 
Vice President Christina 
Hammock will be unveiling 
the complex world of high-
volume documentation in her 
workshop: Advanced Microsoft Word Applications.  
She will reveal the secrets of managing 400+ page 
documents and other intimidating tasks. 
 
The Future Technical Communicators at UCF will 
host these free workshops in the Technical Writing 
Lab in Colburn Hall, room 203.  All events will 
take place between noon and 1:30 p.m., and a 
light lunch will be provided.  If you are interested 
in teaching or attending one of these 
groundbreaking workshops, please e-mail  
futuretek2004@hotmail.com.   MtMMtMMtM 

 

 

 

 

 

 

Upcoming FTC Workshops (Fall '04) 
 
September 25, 2004: Advanced Word—Learn 
how to manage large Word documents, 
professionally format collaborative projects, 
and prepare your document for the printing 
press. 
 
October 9, 2004: Healthcare PACS— Steven 
Shim of Health First will introduce the 
emerging technology of Picture Archiving and 
communication System (PACS) and show us 
the strategies Health First is using to adopt 
and deploy this new industry tool. 
 
October 23, 2004: Dreamweaver Basics 
Learn how to create impressive web pages or 
update your existing sites with this easy to 
learn and easy to use tool. 
 
November 6, 2004: CSS Basics—Learn how 
to create Cascading Style Sheets that will 
revolutionize the way that you write for the 
web. 
 
November 20, 2004: Introduction to 
Macromedia Flash—Learn how to integrate 
video, audio and high resolution graphics into 
your presentations, web site, or e-learning 
interface. 

Risk more than others think is safe. 
Care more than others think is wise. 
Dream more than others think is practical. 
Expect more than others think is possible. 
- Author Unknown 
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Disability Mentoring Day Coming 
Soon! 
By Trena Lackey, Orange County Schools 

On October 20, students with disabilities will have an 
opportunity to gain hands-on experience or job shadow in the 
career field of 
their choice 
during 
Disability 
Mentoring Day 
(DMD). You 
can take part in 
DMD just by 
doing your job 
and allowing 
one or a group of students to observe or participate in daily 
activities and duties at your work place. 
 
Florida’s statewide DMD planning committee consists of The 
Able Trust, Division of Vocational Rehabilitation, 
Commission for Transportation Disadvantaged, Florida 
Community College System, Governor’s Mentoring Initiative, 
Governor’s ADA Working Group, and Volunteer Florida. 
This year, George Koehn, president and CEO of SunTrust 
Banks, Florida, is serving as the honorary chair of the 
statewide planning committee. 
 
If you are interested in participating in this year’s annual 
DMD as a workplace mentor, visit www.abletrust.org for a 
complete listing of local coordinators. If you don’t see your 
community listed, please contact Abby Cruz toll-free at 888-
838-ABLE (2253) or e-mail abby@abletrust.org.   MtMMtMMtM 

IMPORTANTIMPORTANT  
Start budgeting now for:  

 
Your Annual STC Membership 

Renewal 
The STC Annual Conference 

Help Support Orlando-STC. 
Click on the button to go to 

Amazon.com. Remember: A 
percentage of your purchase is 
rebated to the Orlando Chapter 
when you use our click-through. 

“Tell me about yourself.”   
 

While technically this is not a question, it is one of the most 
common ways to begin the interview session.  Since you 
only have one chance to make your first impression, this 
question can be deadly for you if you’re not prepared for it.  
Interviewers love this open-ended question because it 
allows them to gather a snapshot of information about you 
without having to ask potentially illegal questions. 
 
This is your chance to tell the long version of your “elevator 
speech” which I’ve covered in previous Memo to Members 
articles.  You will want to cover your professional history 
explaining how you got to your current point in life; 
however you don’t want your answer to be 100% canned.  
The “gotchas” in this question lie in how you respond to it. 

 
Make it memorable.  Assess the landscape both before 
the interview and during the interview.  Look for 
common areas of interest in the interviewer’s office, 
like hints of a favorite sports team, book, CD, picture, 
poster, etc. Try to include something about your 
background that may spark a common interest with the 
interviewer.  People like people who are like 
themselves, and this “bond” may be the one thing that 
helps your interviewer remember you. 

 
Don’t be afraid to be human.  Include a couple of 
hobbies or activities that make you who you are, but 
keep your answer professional in nature. 

 
Stay away from controversial topics.  Stay away 
from potentially controversial topics too.  While you 
may be a proud leader of an organization, group, 
political party, etc., you don’t know how that cause sits 
with your potential employer.  Since the job interview 
is about hiring you based on your qualifications, simply 
frame your experiences with that group in generic 
terms.  This is not the time to advance the cause of your 
group. 

 
Don’t be long-winded.  If you find yourself still 
talking after 3 or 4 minutes, you’ve gone too long! 

 
Relax.  Remember that your interviewer wants you to 
enjoy yourself and doesn’t want you to be nervous.  

 
As your employment committee manager, and a former 
recruiter, I’m always available to discuss any of your 
questions in strictest confidence.  Feel free to drop me a line 
anytime at rphipps@ciber.com.   MtMMtMMtM 

Interview Question Gotchas 
By Richard Phipps, Employment Committee 
Manager 
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Tool Tips: Word Version Detection 
By David Coverston, Chapter Secretary 

My Tool Tips articles are inspired by 
problems I have to deal with in the everyday 
work of technical communication. This article 

has to do with a problem I had trying to determine the 
version of Word with which some files were created. 
Opening the files and examining their properties would tell 
me which template they were attached to, so I could 
deduce the version of Word that created the files from that. 
But with the number of files I needed to examine, that 
would be a long and tedious process, and I’m not inclined 
to do things manually when I can figure out a way to 
automate them.  
 
A diligent search of the Internet landed me on the Microsoft 
Knowledge Base Article 224351 - Dsofile.exe Lets You Edit 
Office Document Properties from Visual Basic and ASP. The 
article describes the dsofile.exe, a “self-extracting executable 
that provides a simple in-process ActiveX component for 
programmers to use in order to read and modify the 
Document Summary Properties for an OLE Structured 
Storage file such as native Excel, PowerPoint, Microsoft 
Visio, and Word documents.” In plain English, that means 
that you can find out the document properties, such as the 
Word version type, without opening the files if you know 
how to program in Visual Basic. Fortunately, the Visual 
Basic for Applications built into Office applications let me 
use this file to do just what I needed. Even better, a gracious 
person has already done the programming and made it 
accessible for anyone to use.  
 
To get set up, you need to download two files: dsofile.exe,  
available from http://download.microsoft.com/download/
office97dev/Utility/2/WIN98/EN-US/Dsofile.exe and 
Listprops.dot, available from http://word.mvps.org/
Downloads/Listprops.zip.  
1. Double-click the dsofile.exe you downloaded to 

install the ActiveX components you will need.  
2. Click “Yes” when asked if you want to install the 

OLE Document Property Reader. 

3. Click Yes in the License Agreement dialog box. 
4. Choose a location to install the sample files. Don’t 

worry too much about where you put these files, since 
you won’t directly be using them.  

5. Now extract Listprops.dot from the Listprops.zip you 
downloaded and place the extracted file in your Startup 
directory for Word. 

If you don’t know where that is, the easiest way to find it is 
to have Word tell you. To do this, open the Visual Basic 
Editor by choosing Tools > Macro > Visual Basic Editor 
from the menu bar. Then open the Immediate Window by 
choosing View > Immediate Window in the Visual Basic 
Editor. Type “MsgBox Application.StartupPath” and press 
Enter. A message box displays the startup path for your 
machine. 

Extracting a template, such as Listprops.dot into this folder 
makes it always available for your use.  
6. Restart Word to set it up for the first time. 

7. The last step of setting up your application is to set an 
early bound reference in the Visual Basic Editor. To do 
this, open your Visual Basic Editor again (I’m assuming 
you restarted Word), and choose Tools > References 
from the File menu. Check the item DS: OLE Document 
Properties 1.4 Object Library in the References dialog 
box and click OK. 

 
The Knowledge Base article says that you need to register 
Dsofile.dll on your system to use it, but the installation I ran 
did this for me. We are now ready to go! 
 

(Continued on page 5) 

The OLE Setup dialog box 

The installation location dialog box 

The Immediate window 

The startup path 
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Tool Tips, continued 

(Continued from page 4) 
Putting the Listprops.dot template into the startup folder 
added a new menu item to the Tools menu in Word. 
Open the Create File List dialog box by choosing Tools 
> List File Properties. 
 
Select the properties of the files you want information 
about by selecting them in the Available Properties list 
and clicking the arrow to transfer them to the Selected 
Properties list. As you can see, there are a lot of 
properties for which you can gather information, some 
of which are only for PowerPoint or other Office 
programs. Select Template to determine the Word 
version of your files. Click Browse to select the folder 
where your files are located. Select the List files in 
subfolders option 
for an even 
broader search. 
Finally, click 
Create List to 
finish. The 
program creates 
your list in a table 
in a new Word 
document.    MtMMtMMtM 
 
 

Reference dialog box 

Create File List dialog box 
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Let’s Reach Out to Help a New Colleague 
“The Power of One”. . . Meet DBCC’s Ed Santsaver 
By Mike Murray, Orlando Chapter President 

The famous American Helen Keller, 
who lost her hearing and sight to a 
mysterious illness at age 1½, once 
made the following commitment to 
herself and the world: 
I am only one, but still I am one. 
I cannot do everything, but still I can      
     do something. 
I will not refuse to do the something 
     that I can do. 
 
Keller went to college, wrote nearly a 

dozen books, traveled all over the world, 
met 12 U.S. presidents, and lived to be 87. 
 
Exciting educational initiatives 
You don’t have to be around Ed Santsaver long before you 
start realizing that he is a great example of “the power of 
one.” After many years of serving the communications needs 
of such Fortune 500 companies as Texas Instruments, Ciba-
Geigy, Microwave Corporation, and TEXTRON, Ed has 
turned his attention to developing the first technical writing 
courses for the Advanced Tech Center at Daytona Beach 
Community College (DBCC). 
 
Ed’s initial efforts began with “dual-enrolled” advanced 
junior and senior high school students who are earning 
college credits. It wasn’t long, however, before he was 
“discovered” by college students and professors who are 
clamoring for his courses due to the demands of today’s job 
market. As a result, Ed has initiated development of a web 
site that will be used to teach technical writing and design 
communications distance learning courses to college 
students. 
 
Ed is one of the most positive, energetic, imaginative human 
beings you will ever meet. He has many exciting ideas and 
innovative approaches to serving his community and 
profession. While Ed currently has the backing of his 
director at DBCC, he has been pursing these initiatives on 
his own up until now. 
 
Orlando Chapter STC support 
Recently, Ed heard about the Orlando Chapter STC and 
attended our first meeting of the 2004-2005 chapter year, 
which happened to be the energetic and hugely successful 
“Washlines X: Baltimore Comes to Orlando.” That same 
night, Ed joined STC and STC joined Ed! 
 
He was immediately supported with some of the excellent 
resources that have been produced by our Education 
Committee under the leadership of (now retired) committee 
manager Dan Voss. Ed has found the committee’s technical 
communications multimedia presentation particularly useful.  

He says the materials “really turn on the students and 
simplify everything without boring lectures.” 
 
In addition, newly installed Education Committee manager 
Gail Lippincott has already been providing Ed with a wealth 
of information and positive support even though she is in the 
middle of a move from Dallas to Orlando! 
 
Ed had the materials, support, and momentum to fulfill his 
dream of integrating technical communications with 
technical class work – then Hurricanes Charley and Frances 
reared their ugly heads. 
 
 

Destructive fury of Hurricanes 
Charley and Frances 

Hurricane Charley delivered a 
major shot to Ed Santsaver, 

inflicting fairly extensive 
damage upon his home, but it 

was still livable.  Then before 
Hurricane Frances crept across 
Florida, its outer bands in the 
fierce right front quadrant 

devoured what remained of Ed Santsaver’s home, along with 
his technical writing books, view foils, and other materials. 
 
As people who love our profession and our Central Florida 
community, the members of the Orlando Chapter of 
Distinction have quickly risen to Ed’s support. An initial call 
to our chapter e-mail listing subscribers resulted in pledges 
of support by an Orlando Chapter member who lives on the 
east coast, and a Suncoast Chapter member on the west 
coast. Both STCers are paying the postage to have some 
replacement materials sent to the Orlando Chapter on Ed’s 
behalf. 
 
The Orlando Chapter’s “Books for Ed 
Night” and drive 
In honor of Ed’s achievements and 
to ensure his future successes, the I 
have proclaimed the September 28 
chapter meeting as “Books for Ed 
Night.” On that special evening, 
members are encouraged to bring 
used technical communications publications, 
view foils, and other presentations with them 
to help replace Ed’s resources that he took so 
long to lovingly collect. All who bring donations will be 
identified in the October edition of Memo to Members. Better 
yet, donors will receive the supreme satisfaction that 
accompanies helping a fellow human being in need. 
 

(Continued on page 7) 

Ed Santsaver 
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(Continued from page 6) 
Can’t make it to the meeting? The drive will continue at our 
October 26 chapter meeting. If you do not normally attend 
meetings, please contact me, Mike Murray, and special 
arrangements will be made to pick up your contributions. You 
can reach me at: 
      Home Phone: 407-384-6657 
      Work Phone:  407-306-4681 
      Work E-mail: mike.murray@lmco.com  
 
When my home e-mail access recovers from the recent 
hurricanes, it will be available to you as well. 
 
“I shall return!” 
The one-two punch of Hurricanes Charley and Frances might 
have slowed Ed Santsaver down a little, but it has certainly 
not stopped him or daunted his positive attitude. Says Ed in a 
recent e-mail, “Like [U.S. Army General] Doug MacArthur 
said, ‘I shall return,’ and so shall this old boy!” His e-mails 
remain upbeat and positive and serve as ongoing evidence of 
the resiliency of the human spirit. 
 
Ed’s approach to life’s challenges brings to mind another 
quote, this one from Henry Miller: 

Life moves on whether we act as cowards or heroes. 
 
Ed’s identity is obvious. Keep the faith, my friend!  MtMMtMMtM 

Power, continued 

AT the next STC Orlando 
chapter meeting on 
September 28, we will be 

collecting used books and 
view foils in support of 
Ed and his important 

work. Now is your chance 
to clear unused clutter 
from your book shelf 
that will be as good as 
gold to someone in 
need. Please make a 
note to yourself to 
gather unused 
technical 
communications and 
design books, as well 
as view foils, and bring 

them with you to our 
9/28 meeting! 

...then you missed the news on the latest ideas in technical 
communication. 
 
As one who did not get to attend the Baltimore conference, I 
really appreciated the time and energy our presenters spent in 
bringing it back home and sharing it with us. If you have been 
to the annual Washline meetings before, you may not have 
recognized this one. Tables were all decked out in nautical 
themes (Baltimore is a port city), complete with matching 
balloons and candles. An elegantly designed program 
schedule guided us to the topic being presented at each table. 
Regrettably, you could not attend all of the presentations, but 
if the ones I heard were representative, they were all great. 
 
The first table I attended was Mike Murray’s. I fell prey to his 
bribe of free beads if you visited his table. (My 5-year-old 
daughter loved 
them.) Since we 
could pick our topics 
I asked Mike to talk 
about the STC 
Transformation 
initiative. Basically, 
the STC is looking 
for ways to adapt to 
changes in the 
workforce. After 
that, Mike went over 
Section 508 and 
communicating the value that technical communicators add.  
 
Then, it was time to move to the next table. W.C. Wiese 
reviewed a couple of topics for us, but his topic “Trends, 
Technologies, and Skill Sets” alone made it worth coming to 
the meeting. Really, what could be more important than 
keeping track of trends in our own profession?  
 
Next, I visited Karen Lane’s table to hear an entertaining talk 
on science writing and metadata. I finished my table tours by 
listening to the inimitable Dan Voss speak about metrics, 
white papers, and “Good, Fast, and Cheap” in a way that only 
Dan can do.  
 
I would be remiss if I did not mention that Bonnie Spivey, 
Robin Horn, Christina Hammock, Laurel Moll, Alex Garcia, 
Jen Selix, and Rose Petralia also hosted tables. Add to that a 
large student turnout, visitors—some from out of town—and 
you have one exciting meeting. Now you can download some 
of this material from the conference, but the presentation of it 
just won't be the same. 
 
See you at the next meeting.  MtMMtMMtM 

If You Missed Our Last Meeting. . .  
By David Coverston, Chapter Secretary 
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September 26-30, 2004 
Chateau Sonesta Hotel 
New Orleans, Louisiana 

Early Registration Discounts Early Registration Discounts 
AvailableAvailable——Register Today Register Today 

www.lavacon.orgwww.lavacon.org  

Juggling 
too many 
projects? 
 
Juggling more deadlines than  
you have time or resources  
to meet? 
 
Attend LavaCon and learn best 
practices for estimating projects,  
meeting multiple deadlines with 
minimal resources, and more. 

Comments from 
Previous Attendees:  

 
“This was a terrific 

conference” 
 

“Best conference I  
ever attended!” 

 
“Great info and 

LOTS of real-world 
Examples. I wish I 

had attended these  
sessions years ago!” 

The International Conference on 
Technical Communication Management 

The First Coast chapter has 
cordially invited us to join them 
in Jacksonville this October for 
an exclusive opportunity to board 

the Carnival Cruise Line's Celebration and learn more about 
the cruise industry in Jacksonville. Please refer to the 
following information for details. 
 
Dear IABC First Coast Members and Friends: 
Please join us on October 28 for an exclusive opportunity to 
go aboard the Celebration and to hear from a panel of 
executives and communicators from Carnival Cruise Lines 
(our host!), Jacksonville Port Authority (JAXPORT) and the 
Jacksonville & the Beaches Convention and Visitors Bureau 
(CVB) who are involved in bringing cruise ships to 
Jacksonville – and keeping them here! 
 
Space is limited, so RSVP today! 
 
Date: Thursday, October 28, 2004 
Time: 11 a.m. (sharp!)* – 2:30 p.m. 
Location: JAXPORT Cruise Terminal For directions to 

Terminal, go to www.jaxport.com/sea/c_drex.cfm 
Cost: Members:  $25, Guests/non-members:  $30  
 
Ship inspection/tour and lunch will be included.  Parking is 
free. 
*  You will need to allow 10-15 minutes for parking and 
security checks, and we must be ready as a group to board on 
time.  Once we go onboard, latecomers will not be allowed to 
join us.   
 
NOTE:  Reservation and payment must be received by no 
later than October 1!   Your legal name, birthdate, job title 
and company name will be required for reservation.   Space is 
limited.  Reservations will be accepted on a first come/first 
serve basis.  Attendees must be 21 years or older.  Photo ID 
will be required for boarding. 
 
To RSVP, contact Kathy McIlvaine at 904-519-1955 or 
kmcilvaine@att.net; payment (by check or money order) 
should be sent to:  
 
Kathy McIlvaine 
IABC First Coast, Vice President-Professional Development 
8217 Bay Tree Lane 
Jacksonville, FL  32256 

IABC Jacksonville Meeting InvitationIABC Jacksonville Meeting InvitationIABC Jacksonville Meeting Invitation   
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As August winds down, I am struggling to put some thoughts 
together about the field of Technical Communication. I don’t 
know about you, but I am worn out talking about the 
economy, the changing technical communications field, the 
war in Iraq, terrorism, and just about everything else. In fact 
I am so bummed that I want a special SIG set up for burnt 
out, fried, and otherwise abused technical communicators. 
Maybe we can call it the Walking Wounded SIG or the Burnt 
Up, Used Up, Dried UP SIG. 
 
OK. I am honestly trying to be funny. But there is some truth 
to the idea that this field is at least 3 years into perhaps the 
worst downward spiral we have experienced in 50 years. 
And many of us are feeling less than perfect, compared to 
how we felt about ourselves a few years back. I mean, don’t 

you just want to have some fun, like 
back in the good old days of 1999. 
Everything was rock and roll, way back 
then. Jobs were plentiful and if you 
didn’t have one on Monday, you surely 
would have a choice between two or 
three jobs on Tuesday.  
 
So, how do we go about feeling better 
about our field and ourselves? I would 
suggest that this is a great time to go 

back to school. Whether you take a course in RoboHelp or 
Java, whether you get into a degreed program or take an 
evening school crafts course, you will be doing something to 
help yourself. Everything you learn eventually adds value.  
 
Last spring, I took a motorcycle maintenance course. I 
thought this wasn’t related to technical communication, but 
then I learned that there actually are technical 
communicators out there putting together the motorcycle 
service manuals we used in class. It never occurred to me 
that my skills could be used in this 
business. 
 
Another positive that came out of 
taking the class was that it got me out 
of the house and got me thinking about 
something other than work. There is 
LOTS of value in that. 
 
A few years back I took a Webmasters’ 
certificate program from a local 
university. It gave my career a good kick at a time I needed 
it. The interesting thing is that I really never became a 
Webmaster, but it sure is great to have that knowledge in my 
inventory of skills. Employers liked to see my interest in 
learning, too. I don’t think it really mattered to them what the 
subject matter was; it showed that I was engaged and willing 

to learn. If you want to stay in this field for the near term, 
maybe it is time to sign up for that technical course to 
advance your skills and differentiate yourself from everyone 
else. 
 
Personally, I do believe that many in STC want to do nothing 

more than be good technical 
communicators. And that is a great 
goal. Not all of us should move on to 
other things like information 
architecture, usability, or project 
management. Some writers simply 
want to be writers and some editors 
want nothing more than to edit. To stay 

in these areas, advanced technical knowledge is essential. 
The more you have, the better. Some of us will go on to 
those other disciplines, but it doesn’t change the fact that we 
are all communicators and need to keep our skills — both 
technical and communication — fresh. 
 
If you haven’t been back to school in the last three years, it is 
time for you to give it serious thought. The STC website 
(http://www.stc.org/academic.asp) has listings of some 
educational programs that are meaningful to our field, but 
don’t forget to check out your local 
colleges and universities. I just found 
out that there is a college in 
Massachusetts which is providing a 
very robust program in Communication 
and Information Science. And yet, even 
with years of chapter experience in 
Massachusetts, I had never heard of this 
program. So the message is to get out 
there and turn over some stones to find 
some of the neat things going on in 
your own community. 
 
I am about to embark on my next learning adventure — a 
Masters of Science, Human Factors in Information Design. I 
recommend that you do the same. 
 
On the STC front, the transformation is progressing. If you 
haven’t heard about the transformation or aren’t clear on 
what is happening with the transformation, contact me or the 
Director of your choice for further information. If we don’t 
have the answers, we probably know someone who does. Be 
sure to check out the transformation pages on the STC 
website — http://www.stc.org/transformation/Default.asp. 
(NOTE: you do have to log in to get to this page.) The 
website is the authoritative source. There are still lots of 
transformation activities underway and the Board will be 
reporting out on the current status of our efforts soon after 

(Continued on page 10) 

Technical Communication: A View From Below  
By Jonathan W. Baker, STC Director/Sponsor Region 1 (submitted by Beth Tanner, STC Director/Sponsor Region 3) 

“I am so bummed 
that I want a 

special SIG set 
up for burnt out, 

fried, and 
otherwise abused 

technical 
communicators.” 

“Jobs were 
plentiful and if you 

didn’t have one 
on Monday, you 

surely would have 
a choice between 
two or three jobs 

on Tuesday.” 

“Employers liked 
to see my interest 
in learning, too.” 

“If you haven’t 
been back to 

school in the last 
three years, it is 
time for you to 
give it serious 

thought.” 



Society NewsSociety News  
****BEST PRACTICES CONFERENCE & INNOVATOR’S FORUM 
JoAnn Hackos's 6th Annual Best Practices Conference will be 
held in Chatham, MA, on October 18-20, 2004, and Innovator's 
Forum on October 21, 2004. For additional information, please 
visit the conference Web site at http://www.
infomanagementcenter.com/BestPractices/2004/index.html.  
 
****INTERCOM ONLINE WEB SITE LAUNCHED! 
Intercom, the magazine of the Society for Technical 
Communication, is published to provide examples and 
applications of technical communication that will promote its 
readers' professional development. Now, members can view 
each month’s issue online! Search articles, get advertising 
information, purchase STC merchandise, and more. Visit  
http://www.stc.org/intercom/.  
 
****ACADEMIC PROGRAMS DATABASE IS UP AND RUNNING   
To assist those interested in pursuing a career in technical 
communication, STC provides a database of academic 
programs worldwide. Schools are welcome to add their 
programs to the database. For more information visit:   
http://www.stc.org/academicDatabase.asp 
 
****FLORIDA TECHNICAL COMMUNICATION COMPETITION 
It's time for the 2004-2005 Florida Technical 
Communication Competition (FTCC). FTCC is a statewide 
competition that recognizes the best technical communication 
materials produced each year. STC membership is not required 
to enter materials or to serve as a judge. The Suncoast Chapter 
has sponsored this competition since 1991. All of the forms 
associated with the Florida Technical Communications 
Competition can be found on the Orlando Chapter Web site at 
http://www.stc-orlando.org/links/links.asp under the “Florida 
Technical Communication Competition” heading.   MtMMtMMtM 
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FYIFYIFYI 
 
According to the latest 
Society membership counts 
as of June 30, 2004, the 
Orlando Chapter ranks: 
 

1st in size in the state of Florida  
2nd in size in Region 3 (Atlanta 1st with 469)  
3rd internationally in the number of student 
members at 40 (New Zealand 1st with 58 and 
Twin Cities 2nd with 55; largest actual student 
chapters are Southwest Missouri State U. with 35 
and Texas Tech U. with 34)  

Technical, continued 

LETTER TO THE EDITORLETTER TO THE EDITOR  
 
Dear MtM Editor: 
 
I’m writing to express my appreciation to 
everyone at STC-Orlando who contributed to 
making the “Washlines” event so successful. 
Although I have been a member of the Orlando 
chapter for several years, this was the first time I 
have been able to attend the yearly, kickoff 
Washlines meeting and I found it even more 
informative than advertised. As I drove home, I 
realized I carried with me a feeling of pride to be 
part of an organization that makes such 
extraordinary efforts to care for and provide value 
to its members. As always, the opportunity to 
socialize and learn together with so many talented 
colleagues made our August meeting valuable. 
Thanks again to all the contributors and 
participants. 
 
Regards,  
Mark Wray 

(Continued from page 9) 
the September Board meeting. In addition, we are already 
planning sessions on the transformation for our annual 
conference in May. If there is something you want to see 
or hear from us, let us know. 
 
Look for some changes in your membership renewal forms 
this year. We are beginning to roll out the new 
membership packages – Classic, Limited, E-Membership, 
and others – this fall. Again, if you have questions about 
these packages, contact me or another Director. In 
addition, the office will be able to answer any questions 
about the membership packages. 
 
Finally, it is September. That means your chapter is about 
to get into full gear. I’ve chatted with many of the Region 
1 chapter presidents and you have a great group of people 
working on your behalf. Get out and support them by 
attending chapter events. It is a great way to network and 
keep up with your local technical communications 
community. In fact, volunteer! Most chapters will 
welcome you with open arms. And chapter work is 
extraordinarily rewarding. So jump in and see what 
happens.    MtMMtMMtM 
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YYYOUROUROUR O O OPINIONPINIONPINION C C COUNTSOUNTSOUNTS   
Remember to let a chapter leader (red badge) 

know if you have any ideas for ways we can make 
chapter meetings even more valuable to you.  MtMMtMMtM 

Washlines X was a smashing 
success and an excellent 
kickoff to what can only be 
described as a roller-coaster 

year of fun, exciting, and 
informative presentations. 

 
But wait, there’s more. In addition to our monthly 
chapter meetings, take note of the awesome FTC 
Saturday Workshops being offered by our friends at 
UCF.  Plus, you can sign up for one of STC’s 
incredible Telephone/Web Seminars. That is, if you 
still haven’t been overwhelmed by all your 
membership has to offer. So, what are you waiting 
for? Get out there and enjoy your membership! 
 
As always, I welcome your feedback and opinions, so 
feel free to e-mail me at newsletter@stc-orlando.org. 
 
Thanks for reading, 
Erika 

FFFROMROMROM   THETHETHE E E EDITORDITORDITOR’’’SSS D D DESKESKESK   

Memo to Members is published monthly for members of the STC-Orlando chapter 
and distributed via our e-mail distribution list. This newsletter is also available on 
our chapter Web site at www.stc-orlando.org under the link Newsletters. Comments, 
suggestions, and questions are always welcome and should be directed to the Editor, 
Erika Coto, at newsletter@stc-orlando. 
 

Please submit articles, graphics, and letters of opinion for publication. Note: By 
submitting an item for publication, you implicitly grant a license to Memo to Mem-
bers to run the article and for any other STC publications to reprint it without per-
mission. Copyright is held by the writer. Please let the editor know if an item you are 
submitting has run elsewhere and if it has been submitted for consideration to other 
publications. Permission to reprint any material herein is given provided that credit 
is given and a copy of the issue is sent to the editor. 

THE ORLANDO CHAPTER OF STC 
WELCOMES THE FOLLOWING NEW 

MEMBERS! 

Daniel Heath 
Tom Tiedemann 

Allison Johnson (transfer) 

BE HEARD! 
  Write a letter to the editor 

 
  Contribute an article to MtM. 

(For submission guidelines contact 
newsletter@stc-orlando.org) 
 

 Give a presentation at one of 
our monthly chapter meetings. 

      Mark Your Calendars!Mark Your Calendars!Mark Your Calendars!   
   

September 28th: Chapter Meeting at the 
Winter Park Civic Center, 6:30 PM 

 
October 13th: Council Meeting 

 
October 16th: Boss’ Day, Sweetest Day 

 
September 29, 2004: Cascading Style Sheets: Creating 
Layouts without Tables (Part II)                                  
Presenter: Char James-Tanny. Level: Beginner/Intermediate. 
Type: Web-Telephone. http://stc.webex.com/ 

 
October 6, 2004: Communicating With Older Audiences 
Presenters: Dana Chisnell and Amy Lee. Level: Advanced 
Type: Web-Telephone. http://stc.webex.com/  

 
October 20, 2004: A Brief, Comprehensive Indexing Primer 
Presenter: Seth Maislin. Level: All Levels. Type: Web-
Telephone. http://stc.webex.com/ 

Mailing Address:  
STC Orlando, P.O. Box 540444 Orlando, FL 32854-0444 
www.stc-orlando.org 
 
Contact Us: 

President: Mike Murray 
president@stc-orlando.org 
 

Vice President: Christina Hammock 
vicepresident@stc-orlando.org 
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